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ภาคผนวก ก 
 
  -  รายนามผูทรงคุณวุฒิในการตรวจเคร่ืองมือวิจัย 
  -  หนังสือราชการที่เกี่ยวของ 
  -  แบบประเมินคุณภาพดานเน้ือหา และดานเทคนิค 
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รายนามผูเชี่ยวชาญตรวจสอบเคร่ืองมอื 
 

1. นายสุริยัน   บุพศิริ 
 ตําแหนง หัวหนาฝายบริการวิชาการ วิทยาลัยเทคโนโลยีปญญาภิวัตน 
 
2. นางเขมิกา   ภาคเกษี 
 ตําแหนง รองหัวหนาแผนกคอมพิวเตอรธุรกิจ วิทยาลัยเทคโนโลยีสยามบริหารธุรกิจ 
 
3. นายเติมศักดิ์   แสงนาค 
 ตําแหนง หัวหนาสาขาวิชาคอมพิวเตอร กราฟก วิทยาลัยเทคโนโลยีสยามบริหารธุรกิจ 
  นนทบุรี 
 
4. นายธันญชกร  กัปโก 
 ตําแหนง รองหัวหนาแผนกเทคโนโลยีสารสนเทศและส่ือดิจิตอล วิทยาลัยเทคโนโลยีสยาม 
  (สยามเทค) 
 
5. นายยุทธนา   ยุทธยงค 
 ตําแหนง หัวหนาสาขาคอมพิวเตอรสารสนเทศ วิทยาลัยเทคโนโลยีสยามธุรกิจ 
  ในพระอุปถัมภฯ 
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แบบประเมินส่ือการเรียนสําหรับผูเชี่ยวชาญ 
(ดานเนื้อหา) 

ประเภท :  บทเรียนคอมพิวเตอรชวยสอนผานเว็บ เร่ืองการใชโปรแกรมกราฟก  
วิชา : วิชาการใชโปรแกรมกราฟก รหัสวิชา 2201-2419 จํานวน 2 หนวยกิต  
  จํานวน 4 คาบ/สัปดาห สําหรับนักศึกษาระดับช้ันประกาศนียบัตรวิชาชีพช้ันปท่ี 2 
 
คําชี้แจง : โปรดทําเคร่ืองหมาย ลงในชองประเมินตามความคิดเห็นของทาน 
 

ระดับความคิดเห็น 

ดีม
าก

 

ดี 

ปา
นก

ลา
ง 

พอ
ใช
 

คว
รป

รับ
ปรุ

ง 

รายการ 

5 4 3 2 1 
1. เน้ือหาวิชา 
    1.1 ความสมบูรณของวัตถุประสงค      
    1.2 ความสอดคลองของจุดประสงคกับเน้ือหาวิชา      
    1.3 ความถูกตองของเน้ือหา       
    1.4 ปริมาณความเหมาะสมของเน้ือหาแตละบทเรียน      
    1.5 ความเหมาะสมของเน้ือหากับระดับของผูเรียน      
2. การดําเนินเรื่อง 
    2.1 ลําดับขั้นในการนําเสนอเน้ือหา      
    2.2 ความชัดเจนในการดําเนินเรื่อง      
    2.3 ความนาสนใจในการดําเนินเรื่อง      
3. การใชภาษา 
    3.1 ความถูกตองของภาษาที่ใช      
    3.2 ความเหมาะสมของภาษาท่ีใชกับวัยของผูเรียน      
    3.3 ความชัดเจนของภาษาที่ใชสื่อความหมาย      
4. แบบทดสอบ 
    4.1 ความชัดเจนของคําสั่งและคําถามของแบบทดสอบ      
    4.2 ความสอดคลองระหวางแบบทดสอบกับจุดประสงค      
    4.3 ชนิดของแบบทดสอบท่ีเลือกใช      
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ระดับความคิดเห็น 

ดีม
าก

 

ดี 

ปา
นก

ลา
ง 

พอ
ใช
 

คว
รป

รับ
ปรุ

ง 

รายการ 

5 4 3 2 1 
    4.4 ความเหมาะสมของจํานวนแบบทดสอบตอบทเรียน      
    4.5 ความถูกตองของวิธีการรายงานผลคะแนนของแบบทดสอบ      
5. การจัดการบทเรียน (การเรียนรูแบบโครงงาน) 
    5.1 การจัดกลุมผูเรียนตามระดับความสามารถมีความเหมาะสม      
    5.2 รูปแบบการจัดการเรียนรูสงเสริมใหเกิดการเรียนรูรวมกัน      
    5.3 การใหแรงจูงใจเพ่ือสนับสนุนการเรียนรูรวมกัน      

 
ความคิดเห็นเพิ่มเติม 
………………………………………………………………………………………………………. 
………………………………………………………………………………………………………. 
………………………………………………………………………………………………………. 
 
     ลงช่ือ ……………………………… 
               (..…………………………….) 
              ผูประเมิน 
     วันท่ี............../................../................ 
 

ขอขอบคุณทุกทานท่ีใหความอนุเคราะห 
ศิริเพ็ญ  กันจนาธิมาศ 

ผูวิจัย 
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แบบประเมินส่ือการเรียนสําหรับผูเชี่ยวชาญ 
(ดานเทคนคิ) 

ประเภท : บทเรียนคอมพิวเตอรชวยสอนผานเว็บ เร่ืองการใชโปรแกรมกราฟก  
วิชา : วิชาการใชโปรแกรมกราฟก รหัสวิชา 2201-2419 จํานวน 2 หนวยกิต 
  จํานวน 4 คาบ/สัปดาห สําหรับนักศึกษาระดับช้ันประกาศนียบัตรวิชาชีพ ช้ันปท่ี 2 
 
คําชี้แจง : โปรดทําเคร่ืองหมาย ลงในชองประเมินตามความคิดเห็นของทาน 
 

ระดับความคิดเห็น 

ดีม
าก

 

ดี 

ปา
นก

ลา
ง 

พอ
ใช
 

คว
รป

รับ
ปรุ

ง 

รายการ 

5 4 3 2 1 
1. สวนการออกแบบ 
    1.1 การออกแบบสวนประกอบบนหนาจอภาพ      
    1.2 ความเหมาะสมของการใชสีและขนาดของภาพและตัวอักษร      
    1.3 ความสอดคลองของภาพกับเน้ือหา       
    1.4 ความชัดเจนของภาพกราฟกที่ใชประกอบบทเรียน      
    1.5 ความสะดวกในการใชงาน      
2. ดานการจัดการบทเรียน 
    2.1 การลงทะเบียนเรียน      
    2.2 เน้ือหาในบทเรียนมีการถายทอดความรูดวยการอธิบายและ   
ยกตัวอยางชัดเจนทําใหเขาใจเน้ือหา 

     

    2.3 การเรียงลําดับขั้นตอนในการเรียน      
    2.4 การปฏิสัมพันธ และการใหผลตอบกลับ      
    2.5 การบันทึกกิจกรรมและการติดตามผูเรียน      
    2.6 การบริหารจัดการขอมูลและผูสอน      
    2.7 การรายงานผลขอมูล และสถิติตาง ๆ สําหรับผูสอน      
    2.8 การรายงานผลขอมูล และสถิติตาง ๆ สําหรับนักเรียน      
3. ดานการสนับสนุนการเรียนโดยใชการเรียนรูแบบโครงงาน 
    3.1 การจัดกิจกรรมการเรียนรูมีความเหมาะสม      
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ระดับความคิดเห็น 

ดีม
าก

 

ดี 

ปา
นก

ลา
ง 

พอ
ใช
 

คว
รป

รับ
ปรุ

ง 

รายการ 

5 4 3 2 1 
    3.2 การจัดกิจกรรมการเรียนรูบนเว็บใหความชวยเหลือดานการเรียนทั้งใน 
          และนอกเวลาเรียน 

     

    3.3 กิจกรรมในบทเรียนเสริมสรางการเรียนรูดวยตนเองของผูเรียน      
    3.4 รูปแบบของการจัดหองสนทนา (Chat-Room) สนับสนุนใหเกิดการเรียนรู 
          รวมกัน 

     

    3.5 แบบฝกทักษะระหวางเรียนสนับสนุนใหเกิดการเรียนรู      
4. ดานสิ่งอํานวยความสะดวก 
    4.1 การบริการดาวนโหลดอัพโหลดขอมูลประกอบการเรียน      
    4.2 การติดตอสื่อสารผานกระดานถาม-ตอบ      
    4.3 การติดตอสื่อสารผานหองสนทนาอิเล็กทรอนิกส      
    4.4 การประกาศขาวสารและกิจกรรม      

 
ความคิดเห็นเพิ่มเติม 
………………………………………………………………………………………………………. 
………………………………………………………………………………………………………. 
………………………………………………………………………………………………………. 
 
     ลงช่ือ ……………………………… 
               (..…………………………….) 
              ผูประเมิน 
     วันท่ี............../................../................ 
 

ขอขอบคุณทุกทานท่ีใหความอนุเคราะห 
ศิริเพ็ญ  กันจนาธิมาศ 

ผูวิจัย 
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การประเมินความสอดคลอง (IOC) ของแบบประเมินคุณภาพบทเรียนคอมพิวเตอรชวยสอนผาน
เว็บดวยโปรแกรม Learn Square ดานเน้ือหา เร่ืองการใชโปรแกรมกราฟก สําหรับนักศึกษา
ระดับช้ันประกาศนียบัตรวิชาชีพ ชั้นปท่ี 2 
 
คําชี้แจง โปรดพิจารณาแบบประเมินความสอดคลองในแตละขอตอไปนี้วาเนื้อหาของบทเรียน
คอมพิวเตอรชวยสอนผานเว็บสอดคลองกับดานส่ือเทคนิคของบทเรียนคอมพิวเตอรชวยสอนดวย
โปรแกรม Learn Square หรือไม โดยทําเครื่องหมาย √ลงในชอง “ระดับความสอดคลอง” ตาม
ความคิดเห็นของทาน โดยมีผลการประเมินดังตอไปนี้ 
 +1 เม่ือทานเห็นวามาตรฐานรายวิชาและสมรรถนะยอย สอดคลองกับคุณลักษณะ 
การนําเสนอบทเรียนคอมพิวเตอรชวยสอนผานเว็บดวยโปรแกรม Learn Square เร่ืองการใช
โปรแกรมกราฟก 
 0 เม่ือทานไมแนใจวามาตรฐานรายวิชาและสมรรถนะยอย สอดคลองกับคุณลักษณะ
การนําเสนอบทเรียนคอมพิวเตอรชวยสอนผานเว็บดวยโปรแกรม Learn Square เร่ืองการใช
โปรแกรมกราฟก 
 -1 เม่ือทานเห็นวามาตรฐานรายวิชาและสมรรถนะยอย ไมสอดคลองกับคุณลักษณะการ
นําเสนอบทเรียนคอมพิวเตอรชวยสอนผานเว็บดวยโปรแกรม Learn Square เร่ืองการใชโปรแกรม
กราฟก 
 

ระดับความสอดคลอง 
รายการประเมิน 

+1 0 -1 
1. ความสอดคลองของจุดประสงคกับเน้ือหา    
2. ความถูกตองของเน้ือหา    
3. ความสอดคลองของภาพกับเน้ือหา    
4. ลําดับขั้นตอนในการนําเสนอเน้ือหา    
5. การใชภาษาเหมาะกับระดับผูเรียน    
6. ความชัดเจนในการอธิบายเน้ือหา    
7. ความเหมาะสมของแบบฝกหัด    
8. ความเหมาะสมในการแจงผลคะแนนแบบฝกหัด    
9. ความเหมาะสมของแบบทดสอบวัดผลสัมฤทธิ์    
10. ความเหมาะสมในการแจงผลคะแนนแบบทดสอบวัดผลสัมฤทธิ์    
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การประเมินความสอดคลอง (IOC) ของแบบประเมินคุณภาพบทเรียนคอมพิวเตอรชวยสอนผาน
เว็บดวยโปรแกรม Learn Square ดานส่ือเทคนิค เร่ืองการใชโปรแกรมกราฟก สําหรับนักศึกษา
ระดับช้ันประกาศนียบัตรวิชาชีพ ชั้นปท่ี 2 
 
คําชี้แจง โปรดพิจารณาแบบประเมินความสอดคลองในแตละขอตอไปนี้วาเนื้อหาของบทเรียน
คอมพิวเตอรชวยสอนผานเว็บสอดคลองกับ ดานส่ือเทคนิคของบทเรียนคอมพิวเตอรชวยสอนดวย
โปรแกรม Learn Square หรือไม โดยทําเครื่องหมาย √ลงในชอง “ระดับความสอดคลอง” ตาม
ความคิดเห็นของทาน โดยมีผลการประเมินดังตอไปนี้ 
  +1 เม่ือทานเห็นวามาตรฐานรายวิชา และสมรรถนะยอย สอดคลองกับคุณลักษณะการ
นําเสนอบทเรียนคอมพิวเตอรชวยสอนผานเว็บดวยโปรแกรม Learn Square เร่ืองการใชโปรแกรม
กราฟก 
 0 เม่ือทานไมแนใจวามาตรฐานรายวิชา และสมรรถนะยอย สอดคลองกับคุณลักษณะ
การนําเสนอบทเรียนคอมพิวเตอรชวยสอนผานเว็บดวยโปรแกรม Learn Square เร่ืองการใช
โปรแกรมกราฟก 
 -1 เม่ือทานเห็นวามาตรฐานรายวิชา และสมรรถนะยอย ไมสอดคลองกับคุณลักษณะ
การนําเสนอบทเรียนคอมพิวเตอรชวยสอนผานเว็บดวยโปรแกรม Learn Square เร่ืองการใช
โปรแกรมกราฟก 
 

ระดับความสอดคลอง 
รายการประเมิน 

+1 0 -1 
1. วีดีโอ    
 1.1 ความเหมาะสมของปริมาณวีดีโอกับเน้ือหา    
 1.2 การเลือกใชวีดีโอเหมาะสมกับเน้ือหา    
 1.3 ความนาสนใจของวีดีโอที่ใชประกอบ    
 1.4 ความชัดเจนของวีดีโอกับบทเรียน    
2. เสียง    
 2.1 ความชัดเจนของเสียง    
 2.2 ความเหมาะสมของเสียงที่ใชประกอบ    
3. ตัวอักษร    
 3.1 ความเหมาะสมของขนาดตัวอักษร    
 3.2 ความเหมาะของการเลือกสีตัวอักษร    
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ระดับความสอดคลอง 
รายการประเมิน 

+1 0 -1 
 3.3 ความชัดเจนของตัวอักษรบนพื้นหลังสีตางๆ    
4. สี    
 4.1 ความเหมาะสมของสีพ้ืนหลัง    
 4.2 ความเหมาะสมของการใชสีตางๆในการนําเสนอ    
5. เทคนิคการนําเสนอบทเรียน    
 5.1 ความตอเน่ืองของการนําเสนอเน้ือหา    
 5.2 ความเหมาะสมของการออกแบบหนาจอโดยรวม    
 5.3 ความสะดวกในการใชบทเรียน    
 5.4 ความนาสนใจของการโตตอบบทเรียน    
 5.5 ความสะดวกในการใชงานของหนาเมนูหลักและเมนูยอย    

 
ความคิดเห็นเพิ่มเติม 
………………………………………………………………………………………………………. 
………………………………………………………………………………………………………. 
………………………………………………………………………………………………………. 
 
     ลงช่ือ ……………………………… 
               (..…………………………….) 
              ผูประเมิน 
     วันท่ี............../................../................ 
 

ขอขอบคุณทุกทานท่ีใหความอนุเคราะห 
ศิริเพ็ญ  กันจนาธิมาศ 

ผูวิจัย 
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ภาคผนวก ข 
 
 -  การทดลองใชการพัฒนาบทเรียนคอมพิวเตอรชวยสอนผานเว็บ 
    ดวย Learn Square เร่ือง การใชโปรแกรมกราฟก สําหรับนักศึกษา 
    ระดับช้ันประกาศนียบัตรวิชาชีพ ชั้นปท่ี 2 ทดลองกลุมเดี่ยว จํานวน 3 คน 
 -  การทดลองใชการพัฒนาบทเรียนคอมพิวเตอรชวยสอนผานเว็บ 
    ดวย Learn Square เร่ือง การใชโปรแกรมกราฟก สําหรับนักศึกษา 
    ระดับช้ันประกาศนียบัตรวิชาชีพ ชั้นปท่ี 2 ทดลองกลุมเดี่ยว จํานวน 8 คน 
 -  การทดลองใชการพัฒนาบทเรียนคอมพิวเตอรชวยสอนผานเว็บ 
    ดวย Learn Square เร่ือง การใชโปรแกรมกราฟก สําหรับนักศึกษา 
    ระดับช้ันประกาศนียบัตรวิชาชีพ ชั้นปท่ี 2 ทดลองกลุมเดี่ยว จํานวน 30 คน 
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ผลการทดลองใชการพัฒนาบทเรียนคอมพิวเตอรชวยสอนผานเว็บดวย Learn Square เร่ืองการใช
โปรแกรมกราฟก สําหรับนักศึกษาระดับชั้นประกาศนียบัตรวิชาชีพ ชั้นปท่ี 2 ทดลองกลุมเดี่ยว
จํานวน 3 คน 
 

คะแนนกระบวนการการเรียนรูในแตละกลุม 

พื้นฐาน
คอมพิวเตอร

กราฟก 

ไฟลภาพและ
ความแตกตางฯ 

การเลือก
พื้นท่ีภาพ 

การทํางานกับ 
Layer 

วัดผลสัมฤทธ์ิ 
หลังเรียน 

40 คะแนน 
ท่ี 

10 ขอ 10 ขอ 10 ขอ 10 ขอ 

รวม 

40 ขอ 

1 8 9 8 10 35 33 

2 9 8 9 7 33 35 

3 7 9 7 8 31 34 

รวม 24 26 24 25 99 102 

X  8.00 8.67 8.00 8.33 33.00 34.00 

S.D. 1.00 0.58 1.00 1.53 2.00 1.00 

รอยละ 80.00 86.70 80.00 83.30 82.50 85.00 

     E1=82.50 E2=85.00 
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ผลการทดลองใชการพัฒนาบทเรียนคอมพิวเตอรชวยสอนผานเว็บดวย Learn Square เร่ืองการใช
โปรแกรมกราฟก สําหรับนักศึกษาระดับชั้นประกาศนียบัตรวิชาชีพ ชั้นปท่ี 2 ทดลองกลุมเดี่ยว
จํานวน 8 คน 
 

คะแนนกระบวนการการเรียนรูในแตละกลุม 

พื้นฐาน
คอมพิวเตอร
กราฟก 

ไฟลภาพและ
ความแตกตางฯ 

การเลือก
พื้นท่ีภาพ 

การทํางานกับ 
Layer 

วัดผลสัมฤทธ์ิ 
หลังเรียน 

40 คะแนน 
ท่ี 

10 ขอ 10 ขอ 10 ขอ 10 ขอ 

รวม 

40 ขอ 

1 9 8 7 10 34 35 

2 9 7 10 8 34 36 

3 7 10 8 7 32 32 

4 8 10 8 9 35 33 

5 10 8 9 7 34 34 

6 7 8 7 10 32 33 

7 8 8 9 7 32 32 

8 7 9 8 9 33 34 

รวม 65 68 66 67 226 269 

X  8.13 8.50 8.25 8.38 33.25 33.63 

S.D. 1.13 1.07 1.04 1.30 1.16 1.41 

รอยละ 81.30 85.00 82.50 83.80 83.13 84.08 

E1=83.13 E2=84.08 
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ผลการทดลองใชการพัฒนาบทเรียนคอมพิวเตอรชวยสอนผานเว็บดวย Learn Square เร่ืองการใช
โปรแกรมกราฟก สําหรับนักศึกษาระดับชั้นประกาศนียบัตรวิชาชีพ ชั้นปท่ี 2 ทดลองกลุมเดี่ยว
จํานวน 30 คน 
 

คะแนนกระบวนการการเรียนรูในแตละกลุม 

พื้นฐาน
คอมพิวเตอร

กราฟก 

ไฟลภาพและ 
ความแตกตางฯ 

การเลือก
พื้นท่ีภาพ 

การทํางานกับ 
Layer 

วัดผลสัมฤทธ์ิ 
หลังเรียน 

40 คะแนน 
ท่ี 

10 ขอ 10 ขอ 10 ขอ 10 ขอ 

รวม 

40 ขอ 

1 8 10 8 9 35 36 

2 9 8 9 9 35 33 

3 9 10 8 7 34 34 

4 10 9 10 8 37 36 

5 9 8 8 8 33 33 

6 7 7 8 8 30 33 

7 9 9 9 9 36 31 

8 7 10 8 9 34 36 

9 7 8 10 8 33 32 

10 9 10 8 8 35 32 

11 8 10 8 9 35 36 

12 8 8 9 7 32 32 

13 9 7 9 8 33 34 

14 10 7 8 9 34 33 

15 9 8 7 7 31 29 

16 8 10 9 8 35 34 

17 9 8 9 10 36 33 

18 8 9 7 9 33 37 

19 8 9 8 8 3 36 

20 8 8 9 8 33 32 



มห
าวิท

ยาล
ัยร
าช
ภัฏ
ธน
บุร
ี

  118 

คะแนนกระบวนการการเรียนรูในแตละกลุม 

พื้นฐาน
คอมพิวเตอร

กราฟก 

ไฟลภาพและ 
ความแตกตางฯ 

การเลือก
พื้นท่ีภาพ 

การทํางานกับ 
Layer 

วัดผลสัมฤทธ์ิ 
หลังเรียน 

40 คะแนน 
ท่ี 

10 ขอ 10 ขอ 10 ขอ 10 ขอ 

รวม 

40 ขอ 

21 9 10 9 8 6 36 

22 10 8 10 8 36 33 

23 8 9 9 9 35 38 

24 7 8 8 8 31 35 

25 8 8 7 10 33 33 

26 8 9 8 8 33 34 

27 8 9 10 9 36 34 

28 9 9 9 10 37 38 

29 9 7 9 10 35 35 

30 9 9 8 9 35 36 

รวม 254 259 256 255 1024 1028 

X  8.47 8.63 8.53 8.50 34.13 34.27 

S.D. 0.86 1.00 0.86 0.86 1.78 2.08 

รอยละ 84.70 86.30 85.30 85.00 85.33 85.68 

     E1=85.33 E2=85.68 
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คูมือ 
 

การใชคอมพิวเตอรชวยสอนผานเว็บดวย Learn Square 
เรือ่งการใชโปรแกรมกราฟก 

สําหรับนกัศึกษาระดับชั้นประกาศนียบัตรวิชาชีพ ชั้นปที ่2 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



มห
าวิท

ยาล
ัยร
าช
ภัฏ
ธน
บุร
ี

  120 

ขั้นตอน การเขาสูบทเรียน 
 

กรอบการเรียนรู คําบรรยาย 

 

1. พิมพ  http://www.krupen.org/  
2. คลิกปุม เขาสูบทเรียน 

 

3. คลิกชอง User Name เพื่อกรอกช่ือจริง 
4. คลิกชอง Password เพื่อกรอกรหัสประจําตัว 
5. กดปุม Login 

 

6. คลิกท่ี รายวิชา เพ่ือดูวาในรายวิชานี้มีหนวย
การเรียนใดบาง 
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ขั้นตอน การเลือกและเขาเรียน 
 

กรอบการเรียนรู คําบรรยาย 

 

7. คลิกเลือก 01 พื้นฐาน 
คอมพิวเตอรกราฟก เพื่อเขาเรียน 

 

8. คลิกเพื่อเขาเรียนในบทพื้นฐาน
คอมพิวเตอรกราฟก 

 

9. คลิกเลือก สารบัญ เพ่ือจะเขาชม
วิดีโอ ท่ีนําเสนอพื้นฐาน 
คอมพิวเตอรกราฟก 

 

10. คลิกปุม Play                                
เพื่อชมการนําเสนอพื้นฐาน 
คอมพิวเตอรกราฟก 
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ขั้นตอน การเลือกและเขาทําแบบทดสอบ 
 

กรอบการเรียนรู คําบรรยาย 

 

11. คลิกปุม เนื้อหา เพื่อกลับมาเขา 
แบบทดสอบ 
12. คลิกเขาไปท่ี แบบทดสอบ 

 

13. คลิกเพื่อเลือกชอยคําตอบท่ี 
ตองการ 
14. คลิกปุม ดูผลคะแนน 

** ในบทท่ี 2-4 และแบบทดสอบรวม มีข้ันตอนเชนเดียวกับบทท่ี 1 ** 
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ภาคผนวก ค 
 
   -  แบบทดสอบ 
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จงทําเคร่ืองหมาย O ในหัวขอท่ีถูกท่ีสุดเพียงขอเดียว 
 
1. ขอใดเปนงานคอมพิวเตอรกราฟกท่ีเกี่ยวกับ CAD  
 ก. โปรแกรมคอมพิวเตอรชวยสอน ข. การทําภาพเคล่ือนไหว 
 ค. การออกแบบ ง. การประมวลภาพ 
2. ขอใดเปนงานคอมพิวเตอรกราฟกท่ีเกี่ยวกับ CAI  
 ก. โปรแกรมคอมพิวเตอรชวยสอน ข. การทําภาพเคล่ือนไหว 
 ค. การออกแบบ ง. การประมวลผลภาพ 
3. ขอใดคือหนวยวัดความละเอียดของเคร่ืองพิมพ  
 ก. Pixel ข. DPI 
 ค. LPI ง. PPI 
4. ขอใดคือหนวยวัดความละเอียดของจอภาพ  
 ก. Pixel ข. DPI 
 ค. LPI ง. PPI 
5. ขอใดคาความลึกของสีท่ีเหมือนจริง True Color  
 ก. 16 บิต ข. 24 บิต 
 ค. 32 บิต ง. 64 บิต 
6. โมเดลสีในขอใดคือการผสมสีแบบ Subtractive Color  
 ก. RGB ข. LAB 
 ค. CMYK ง. HSB 
7. โมเดลสีในขอใดคือการผสมสีแบบ Additive Color  
 ก. RGB ข. LAB 
 ค. CMYK ง. HSB 
8. ขอใดคืออุปกรณท่ีใชเปนหนาจอรับขอมูลของเคร่ือง ATM  
 ก. Graphics Tablet ข. Touch Screen 
 ค. Plotter ง. Light Pen 
9. เคร่ืองพิมพเลเซอรท่ีมีความละเอียด 600 dpi สามารถพิมพดวยความถ่ี 150 lpi มีขนาดเซลลฮาลฟ 
 โทนตามจํานวนในขอใด 
 ก. 4 จุด ข. 8 จุด 
 ค. 16 จุด ง. 24 จุด 
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10. เคร่ืองพิมพเลเซอรท่ีมีความละเอียด 600 dpi จะสามารถสรางฮาลฟโทนไดครอบคลุมสีเทาได  
 256 สี จะตองพิมพดวยคาความถ่ีในขอใด 
 ก. 37  lpi ข. 100 lpi 
 ค. 150 lpi ง.  180 lpi            
 
หนวยท่ี 2  จงทําเคร่ืองหมาย  O ในหัวขอท่ีถูกเพียงขอเดียว 
 
1. ขอใดคือไฟลราสเตอรท่ีเปนมาตรฐานของ   Windows   
    ก.  .RAS                                 ข.  .IFF 
   ค.  .BMP                                  ง.  .PCX 
2. ขอใดคือไฟลภาพท่ีถูกบีบอัดใหมีขนาดเล็ก  เหมาะกําการแสดงภาพบนเว็บในลักษณะของภาพ 
 โปรงแสงและภาพเคล่ือนไหว  
    ก.  .BMP                                 ข.  .GIF 
    ค.  .EPS                                   ง.  .JPEG 
3. ขอใดคือไฟลภาพท่ีบรรจุขอมูลเปนไดท้ังแบบเวกเตอรและบิตแมพ ซ่ึงสามารถใชงานขาม 
 โปรแกรมไดดี   
     ก.  .BMP                                 ข.  .GIF 
     ค.  .EPS                                   ง.  .JPEG 
4. ขอใดคือไฟลภาพท่ีไมเกี่ยวของกับงานสรางเว็บไซตบนอินเทอรเน็ต 
     ก.   .IIF                                     ข.   .GIF 
     ค.   .JPEG                                 ง.   .PNG 
5. ขอใดคือไฟลภาพบิตแมตท่ีพัฒนาโดย   Kodak  เพื่อใชในการเก็บภําลงบนแผน  Photo  CD   
     ก. .RAS                                       ข.  IFF 
     ค. .MSP                                        ง.  .PCX 
6. ขอใดเปนไฟลเวกเตอรท่ีถูกตองบันทึกไวเพื่อใหพร้ินเตอรแบบ  PostScript   สามารถอานได 
 โดยตรง  
   ก.  .DXF                      ข.  .PS 
   ค.  .SVG                      ง.   .EPS 
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7. ขอใดเปนไฟลเวกเตอรฺท่ีใชบนเครือขายอินเทอรเน็ต    
    ก.  .DXF                      ข.  .PS 
   ค.  .SVG                      ง.   .EPS 
8. ขอใดคือโปรแกรมท่ีใชในการจัดวางหนังสือส่ังพิมพ 
    ก.   Photoshop          ข.   Dreamweaver 
    ค.   Flash                   ง.  PageMaker 
9. ขอใดคือโปรแกรมทีใชในการจัดวางหนาเว็บเพจ   
    ก.   Photoshop          ข.  Dreamweaver 
    ค.   Flash                   ง.  PageMaker 
10. ขอใดคือโปรแกรมท่ีใชในการสรางภาพเคล่ือนไหวแบบเวกเตอร   
    ก.   Photoshop         ข.   Dreamweaver 
    ค.   Flash                   ง.  PageMaker 
 
หนวยท่ี 3  จงทําเคร่ืองหมาย  O ในหัวขอท่ีถูกเพียงขอเดียว 
 
1.  ขอใดไมใชความสามารถของ  Photoshop 
 ก.  งานตกแตงภาพถาย ข.  งานส่ังพิมพ 
 ค.   งานซิลคกรีน ง.   งานเว็บไซตบนอินเทอรเน็ต 
2. ขอใดไมใชสเปคเคร่ืองคอมพิวเตอรท่ีเหมาะสําหรับการติดต้ังโปรแกรม  Photoshop 
 ก.   เคร่ืองคอมพิวเตอร  COP Pentium 4 ข.  Windows  ME 
 ค.   Window  XP  Service  Pack  1 ง. Window  XP  Service  Pack  2 
3.  เราใชกดคียลัดในขอใดแทนการเลือกคําส่ังเปดไฟล  OPEN 
 ก.   <Ctrl+P> ข. <Ctrl+O> 
 ค.   <Ctrl+E>  ง. <Ctrl+N> 
4.  ขอใดคือเคร่ืองมือท่ีอยูในกลุมของการวาดภาพและสรางตัวอักษร 
 ก. ข. 
 
 ค. ง. 
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5.  ขอใดท่ีไมใชคุณสมบัติของ  Palette Well 
 ก.  จะปรากฏแถบ  Palette Well เม่ือใชความละเอียดจอท่ี  1024x768 
 ข.  เราใช  Palette Well สําหรับพักหนาตางพาเล็ตท่ีตองใชงานบอยๆ เพื่อไมบดบังพื้นท่ี 
  การทํางาน และสะดวกในการเรียกใชงาน 
 ค.  Palette Well สามารถชวยปรับขนาดมุมมองในการทํางานของโปรแกรมไดสะดวกกวา 
  การปรับดวยคําส่ัง View 
 ง.   Palette  Well สามารถพักหนาจอพาเล็ตไดมากกวา 1 หนาจอ 
6.  ตัวอักษรยอ  “CS” ในช่ือ Photoshop CS เปนคํายอจากขอใด 
 ก.  Creative Suite ข.  Creative Smart 
 ค.  Creative Sign ง.  Creative Smooth 
7.  กลุมคําส่ังในขอใดท่ีใชในการปรับแตงภาพอัตโนมัติดวยคําส่ังสําเร็จรูป 
 ก.  Image ข.  Layer 
 ค.  Select  ง.  Filter 
8.  กลุมคําส่ังในขอใดท่ีใชในการปรับแตงท่ีมีผลตอภาพทั้งภาพ 
 ก.  Image ข.  Layer 
 ค.  Select ง.  Filter 
9.  ขอใดเปนคํากลาวท่ีเกี่ยวกับการใชแถบคําส่ัง  Menu  bar  ไดไมถูกตอง 
 ก. ในคําส่ังท่ีมีเคร่ืองหมาย  แสดงวาคําส่ังยอยภายใตคําส่ังนั้น 
 ข.  คําส่ังท่ีมีเคร่ืองหมาย...  ตามหลัง  เชน  Place….  แสดงวาเปนตําส่ังท่ีไมถูกอนุญาตใหใชงาน 
  อยางถาวร 
 ค.  คําส่ังเปนสีเทาจาง  หมายถึง ไมอนุญาตใหใชงานคําส่ังในขณะนั้น 
 ง.  Ctrl+N  เปนตัวอยางคียลัดสําหรับใชคียบอรดเรียกคําส่ังแทนการใชเมาสเรียกคําส่ัง 
10.  ขอใดกลาวถึงการใชงานพาเล็ตไมถูกตอง   
 ก.  History  Palette  ใชจัลําดับของพาธท่ีวาดขึ้น  และจัดการเกี่ยวกับพาธตางๆ 
 ข.  เลือกคําส่ัง  Window>Color  เม่ือตองการเปดใช  Color  Palette 
 ค.  Color  Palette  ใชในการเลือกสีของโฟรกราวนด  หรือแบ็คกราวนด  โดยการเล่ือนสไลด 
  ของสี  ตางๆไดเอง 
 ง.   Navigator  Palette  ใชในการปรับขนาด  และมุมมองของภาพ 
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หนวยท่ี 3  จงทําเคร่ืองหมาย  O ในหัวขอท่ีถูกเพียงขอเดียว 
 
1.  ขอใดคือการเลือกพื้นท่ีภาพเปนเสนตรงในแนวนอน 
 ก.  Rectangular Marquee Tool ข.  Elliptical Marquee Tool 
 ค.  Single Row Marquee Tool ง.  Single Column Marquee Tool 
2.  ขอใดคือการเลือกพื้นท่ีภาพท่ีมีใกลเคียงกับคาสี  ณ  จุดพิกเซลท่ีเราคลิกเลือก 
 ก.  Lasso Tool ข.  Polygonal Lasso Tool 
 ค.  Magnetic  Lasso Tool ง.  Magic Wand Tool 
3.  ขอใดคือคุณสมบัติท่ีทําใหขอบพื้นท่ีท่ีเลือกเรียบข้ึน 
 ก.  Feather ข.  Anti-Aliased 
 ค.  Frequency ง. Edge  Contrast 
4.  การเลือกพื้นภาพดวยเคร่ืองมือในขอใดจะไมมี การกําหนดคาความฟุงเบลอ Feather 
   ก.  Lasso Too 
 ข.  Polygonal Lasso Tool 
 ค.  Magnetic Lasso Tool 
 ง.  Magic Wand Tool 
5. ขอใดคือลักษณะการช้ีเมาสของการเลือกพื้นท่ีเฉพาะสวนท่ีตัดกันของพื้นเดิม   

    ก.             ข.   ค.  ง.     
6.  ขอใดคือการเลือกพื้นท่ีภาพในสวนท่ีซับซอน โดยขอบภาพจะเปนเสนผม หรือขนสัตว 
 ก.  Extracting ข.  Qucik  Mask  Mode 
 ค.  Magic  Wand  Tool ง.   Magnetic  Lasso Tool 
7.  ขอใดคือคือคียลัดท่ีใชยกเลิกการเลือกพื้นท่ีท่ีไดเลือกไว 
   ก.  <Alt>+คลิกเมาส ข.  <Ctrl+D> 
 ค.  <Shift>+Ctrl+l> ง.   <Shift>+คลิกเมาส 
8.  ขอใดคือคียลัดของการสลับไปเลือกขอบเขตพื้นท่ีตรงกันขาม 
 ก.  <Ctrl+A> ข.  <Ctrl+D> 
 ค.  <Shift+Ctrl+I> ง.  <Shift+Ctrl+D> 
9. สัญลักษณตัวช้ีเมาสรูป  ส่ือความหมายตรงกับขอใด 
 ก. การเลือกพื้นท่ีใหม ข. การเลือกขอบเขตภาพเพิ่มเติมจากเดิม 
 ค. การเลือกขอบเขตท่ีเลือกไวจากเดิม ง. การเลือกพื้นท่ีจนครบรอบท่ีตองการ 
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10.  ขอใดคือการใสเสนขอบลงในพ้ืนท่ีท่ีเลือกไว 
   ก. คําส่ัง Edit>Fill ข. คําส่ัง Edit>Stroke 
 ค. เคร่ืองมือ Paint Buckket Tool ง. เคร่ืองมือ Gradient Tool 
 
หนวยท่ี 4 จงทําเคร่ืองหมาย O ในหัวขอท่ีถูกเพียงขอเดียว 
 
1. ขอใดไมใชวิธีการสรางเลเยอรใหม  
 ก. คลิกปุม  ข. คลิกปุม  
 ค. กดคียลัด <Shift+Ctrl+N> ง. เลือกคําส่ัง Layer>New>Layer 
2. ขอใดคือการล็อคภาพเฉพาะในสวนท่ีโปรงใส  
 ก.   ข.  
 ค.   ง.  
3. ขอใดคือการล็อคตําแหนงภาพไมใหมีการเคล่ือนยายได  
 ก.   ข.  
 ค.   ง.  
4. ขอใดหมายถึงการซอนเลเยอร  
 ก.   ข.  
 ค.   ง.   
5. ขอใดคือการสรางเลเยอรกรุปเพ่ือจัดหมวดหมูของเลเยอร  
 ก.  ข.  
 ค.  ง.  
6. ขอใดคือการสรางลิงคสรางความเช่ือมโยงในการทํางานใหกับเลเยอร  
 ก.  ข.  
 ค.  ง.  
7. ขอใดคือการจัดเรียงภาพในเลเยอรท่ีลิงคกันอยูใหวางชิดขอบลาง  
 ก.   ข.   
 ค.   ง.   
8. ขอใดคือการจัดระหางของภาพท่ีลิงคกันอยูใหหางจากขอบซายของภาพเทากัน  
 ก.  ข.  
 ค.  ง.  
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9. ขอใดคือการรวมเลเยอรท่ีมองเห็นอยูใหเปนเลเยอรเดียวกัน  
 ก.   Merge Layers ข. Merge Visible 
 ค.   Merge Link ง. Flatten Image 
10. ขอใดคือการรวมเลเยอรท้ังหมดใหเปนเลเยอรเดียว  
 ก.  Merge Layers ข. Merge Visible 
 ค.  Merge Link ง. Flatten Image 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



มห
าวิท

ยาล
ัยร
าช
ภัฏ
ธน
บุร
ี

  133 

ประวัติผูวิจัย 
 

ชื่อ – นามสกุล นางศิริเพ็ญ  กันจนาธิมาศ 
วัน เดือน ปเกิด 27 กุมภาพันธ 2519 
ประวัติการศึกษา 
 พ.ศ. 2539 ประถมศึกษา โรงเรียนสิริวุฒวิทยา สมุทรปราการ  
 พ.ศ. 2542 มัธยมศึกษาตอนตน โรงเรียนมัธยมวัดนายโรง กรุงเทพมหานคร 
 พ.ศ. 2545 ประกาศนียบัตรวิชาชีพ วิทยาลัยเทคโนโลยีพาณิชยการราชดําเนิน-ธนบุรี 
 พ.ศ. 2547 ประกาศนียบัตรวชิาชีพช้ันสูง วิทยาลัยเทคโนโลยีพาณิชยการราชดําเนิน- 
  ธนบุรี 
 พ.ศ. 2549 ปริญญาตรี สาขาบริหาร (คอมพิวเตอรธุรกิจ) มหาวิทยาลัยสยาม 
 พ.ศ. 2554 ประกาศนียบัตรบัณฑิต สาขาวิชาชีพครู มหาวิทยาลัยราชภัฏธนบุรี 
 พ.ศ. 2557 ปริญญาครุศาสตรมหาบัณฑิต สาขาวิชาหลักสูตรและการสอน  
  มหาวิทยาลัยราชภัฏธนบุรี 
 
ประวัติการทํางาน  
 พ.ศ. 2542-2545 อาจารยระดับ ปวช. และ ปวส. ท่ีวิทยาลัยเทคโนโลยีหมูบานครู 
 พ.ศ. 2552-2556 อาจารยระดับ ปวช. และ ปวส. ท่ีวิทยาลัยเทคโนโลยีสยาม 
   (สยามเทค) 
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